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About D3000.Express 

D3000.Express enables clients to: 

 Select records for a specific building. 

 View and add tenant records. 

 View access levels. 

 View card holder records, and activate, modify and deactivate cards. 

 Assign photo badge templates and print photo badges. 

 Pre-register visitors. 

 Modify the holiday list. 

 View access history. 

 Design photo badge templates. 

Through a secure Internet connection to Datawatch Systems, administrative tasks 
can be handled immediately from anywhere. 

About this manual 

This manual is organized in six chapters: 

 “Installing D3000.Express” shows how to install D3000.Express on your 
computer. 

 “Quick reference” summarizes instructions for using D3000.Express.  Refer to 
this chapter when you need to refresh your memory about how to use the 
program. 

 “Getting started” covers launching the program and logging in, and describes 
how to open building records, work with tables, and select dates and times. 

 “Common tasks” provides step-by-step instructions for performing the most 
common administrative operations. 

 “Advanced tasks” describes additional table operations and tasks that are 
typically performed less frequently. 

 “Using Photo Badge Designer” shows how to design photo badge templates. 
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Installing D3000.Express 

System requirements 

D3000.Express must be installed on a computer running Windows 2000, 
Windows XP, Windows Vista or Windows 7. 

The computer must have Internet access. 

Installation procedure 

1. Using a Web browser, navigate to  
https://secure2.datawatchsystems.com/download/D3000.Express.Setup.msi 

2. In the File Download dialog, click the Open button. 

 Tip:  You can also save the installer file on your local hard drive.  If you do 
this, navigate to the location where you saved the file, then double-click the 
file name. 

 
3. Follow the instructions in the installer. 

 Note:  When you launch the installer, you will see a Security Warning (“The 
publisher could not be verified.  Are you sure you want to run this software?”).  
Click the Run button. 

 
 Tip:  A separate document, “D3000.Express Import Instructions,” enables 

Datawatch personnel to import card holder data and photos from Microsoft 
Excel files. 

 

Program updates 

D3000.Express automatically checks for updates each time you launch it.  It is 
strongly recommended that you install updates as soon as they are available.  
When you see a progress bar similar to the one below, wait until updating 
finishes before proceeding. 
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Quick reference 

Getting started 

To do this... Do this... Details

Log in Launch D3000.Express, enter user name and password, 
select and confirm building to work on. 

Page 9

Open records for a building File > Open Building... , select and confirm building. Page 10

Select a building to work on Click building address at bottom of left panel. Page 11

Select dates 1. Open date field to view calendar. 
2. Navigate to desired year and month. 
3. Click desired day of month. 

Page 13

Common operations 

To do this... Do this... Details

View tenant list Click Tenant List icon in left panel. Page 14

Add tenant 1. Click Tenant List icon in left panel. 
2. Click Edit button in lower right corner, then click 

Append button  in Edit Bar. 
3. Fill in fields in Tenant Detail dialog, click Save button, 

then click Close button. 

Page 14

View access levels Click Access Level List icon in left panel. Page 15

View all card holder records 1. Click Card Holder List in left panel. 
2. Click Search button in Card Holder Search panel. 

Page 17

View specific card holder 
records 

1. Click Card Holder List in left panel. 
2. Specify Tenant, Site Code, Emboss#, Name or 

Expiration Date in Card Holder Search panel, then 
click Search button. 

Page 17

Activate new card 1. Click Card Holder List in left panel. 
2. Click Edit button in lower right corner, then click 

Append button  in Edit Bar. 
3. Fill in fields in Card Holder Detail dialog, click Save 

button, then click Close button. 

Page 18

Deactivate card 1. Click Card Holder List in left panel. 
2. Scroll or search to find record to be deleted, then click 

that row. 
3. Click Edit button in lower right corner, then click Delete 

button  in Edit Bar. 
4. In Delete Warning dialog, click OK. 

Page 21 

Modify card 1. Display card holder records (see above). 
2. Scroll or search to find record to be modified, then 

double-click that row. 
3. Click Edit button.  Edit fields as needed, click Save 

button, then click Close button. 

Page 30
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Common operations (continued) 

To do this... Do this... Details

Pre-register visitor 1. Click Visitor List icon in left panel. 
2. Click Edit button in lower right corner, then click 

Append button  in Edit Bar. 
3. Fill in fields in Visitor Detail dialog, click Save button, 

then click Close button. 

Page 30

Modify pre-registered visitor 1. Click Visitor List icon in left panel. 
2. Scroll or search to find record to be modified, then 

double-click that row. 
3. Click Edit button.  Edit fields as needed, click Save 

button, then click Close button. 

Page 32

Remove pre-registered visitor 1. Click Visitor List icon in left panel. 
2. Scroll or search to find record to be deleted, then click 

that row. 
3. Click Edit button in lower right corner, then click Delete 

button  in Edit Bar. 
4. In Delete Warning dialog, click OK. 

Page 33

 

Advanced operations 

To do this... Do this... Details

Modify holiday list 1. Click Holiday List icon in left panel. 
2. Click Edit button in lower right corner to display Edit 

Bar, then: 

 To add holiday:  Click Append button  , specify 
details, then click Save and Close. 

 To modify holiday:  Click holiday record, click Edit 

button  , edit details, then click Save and Close. 
 To delete holiday:  Click holiday record, click Delete 

button  , confirm deletion. 

Page 38

View access history 1. Click Access History List icon in left panel. 
2. Specify From and Thru dates and times. 
3. Select Tenant and/or restrict search in tabs. 
4. Click Search All button. 

Page 39
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Getting started 

This chapter shows how to log in to D3000.Express, and describes several 
functions that are used throughout the program. 

Launch D3000.Express and log in 

1. Launch D3000.Express: 

 Double-click the D3000.Express shortcut on the desktop. 
  or 
 Locate and click D3000.Express in the computer’s Start menu. 

2. In the Login dialog:  

a. Enter your User Name, or open the User Name list and select the user 
name you want to use. 

b. Enter your Password. 

 Note:  Datawatch issues user names and passwords.  If you haven’t received 
a user name and password, please contact Datawatch Customer Service. 

 
c. Click the Login button. 

 

 Tip:  If you can’t remember your password, click the Forgot Password link.  
In the Recover Password dialog, enter your User Name, then click the 
Retrieve Password button.  Your password will be sent to your e-mail 
address. 

 
3. In the Select Building dialog: 

a. Locate and click the address for the building you want to work on. 

b. Click the OK button. 

4. The D3000.Express main window opens. 
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 Note:  If you don’t use D3000.Express for 15 minutes, it locks up (to prevent 
unauthorized use) and displays the Unlock D3000.Express dialog.  

 To continue using the program:  Enter your password, then click the Unlock 
button.  Only the person that initially logged in can unlock the program. 

 To change the lock-up time:  Tools > Setting... > App Locker Setting... . 

Open records for a building 

You can work on records for multiple buildings during a D3000.Express session.  
You select one building when you open D3000.Express (see step 3 in “Launch 
D3000.Express and log in,” above), but you can open records for additional 
buildings after launching the program. 

 To open records for another building after launching D3000.Express:   

a. File > Open Building... . 

b. In the Select Address dialog, select the building’s address, then click OK. 

The building’s address will appear in the File menu... 

 

 and at the bottom of the left panel. 
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 To select records you want to work on:  At the bottom of the left panel, click 
the desired address. 

 

 There are two ways to verify that you have selected the correct building: 

 The selected building’s address is in the dark bar at the bottom of the left 
panel (shown in example above). 

 The selected building’s address is displayed at the top of the left panel 
(shown in example below). 
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Basic table operations 

D3000.Express organizes much information in tables.  Data records appear as 
rows, while each column in a row contains data for the fields in that record.  
Since you will work with tables quite often, you should know how to modify 
tables to display the information you need in the way that’s most useful to you. 

 To resize a column:  Move the cursor over the separator to the right of the 
column name (the cursor will change to a double arrow).  Drag the separator 
left or right. 

   

 To resize a column for best fit:  Right-click the column name, then click Best 
Fit in the pop-up menu (upper arrow, below). 

   

 To resize all columns for best fit:  Right-click any column name, then click 
Best Fit (all columns) in the pop-up menu (lower arrow, above). 

 To sort rows according to data in one column:  Click the column name. 

The small arrow next to the column name indicates the sorting direction. 

  
Ascending order Descending order 

 To close a table:  Click this button  in the upper right corner, or click the 

Close button in the lower right corner. 

 To view a table that’s open, but hidden by another table:  Select the table in 
the Window menu. 

 Tip:  Additional table operations are described in the “Advanced Operations” 
chapter. 
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Select dates and times 
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Common tasks 

This chapter details tasks frequently performed in D3000.Express. 

View tenant list 

1. If records for multiple buildings are open, select the building for which you 
want to view the tenant list (see “Open records for a building” in the previous 
chapter). 

2. In the left panel, click the Tenant List icon.   

3. Recommended:  Right-click any column name, then click Best Fit (all 
columns) in the pop-up menu. 

Edit tenant details 

1. If records for multiple buildings are open, select the building for which you 
want to view the tenant list (see “Open records for a building” in the previous 
chapter). 

2. Display tenant records (see “View tenant list,” the previous section in this 
chapter). 
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3. Double-click the tenant record you want to edit.  This opens the Tenant Detail 
dialog. 

 

4. In the Tenant Detail dialog: 

a. Click the Edit button at the bottom of the window. 

b. In the Detail tab, fill in or change data in fields. 

c. In the Card Fields tab, fill in or change custom info labels.  (These labels 
enable recording of card holder information relevant to this tenant’s needs.) 

d. Click the Save button. 

e. Click the Close button. 

 Note:  You cannot delete tenant records.  Please contact Datawatch Systems 
if a tenant must be removed from the tenant list. 
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View access levels 

Access level is used to control the days and times a card holder is allowed access 
to a door.  For example, an access level could allow 24/7 access to one door and 
no access to other doors.  Many combinations are possible.  For any new Access 
Levels that are needed, the customer must call Central Station to have it set up. 

 Note:  You cannot create access levels.  Please contact Datawatch Systems if 
you need a new access level. 

 
1. If records for multiple buildings are open, select the building for which you 

want to view the access levels (see “Open records for a building” in the 
previous chapter). 

2. In the left panel, click the Access Level List icon.   

3. Recommended:  Right-click any column name, then click Best Fit (all 
columns) in the pop-up menu. 

4. For addition information about an access level, double-click its row in the 
table. 
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View card holder records 

1. If records for multiple buildings are open, select the building for which you 
want to view the card holder list (see “Open records for a building” in the 
previous chapter). 

2. In the left panel, click the Card Holder List icon.   

This displays the Card Holder Search panel. 

 

3. Then: 

 To display card holder records matching a search term:  Enter the search 
term in the appropriate field, then click the Search button. 

 To display records for all card holders: 

a. Clear data from all search fields. 

b. Click the Search button. 

c. In the Card Holder Search dialog, click the Yes button. 

 To search for card holders associated with a specific tenant, or having 
specific data in a custom field: 

a. Click the Secondary Search tab in the Card Holder Search panel. 

b. Open the Address field and select the desired address, then open the 
Tenant list and click the tenant’s name. 

c. Open the Customized Fields list and click the custom field to be 
searched, then enter the search term in the Field Value field. 

d. Click the Search button. 
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Activate a new card 

1. If records for multiple buildings are open, select the building for which you 
are activating a new card (see “Open records for a building” in the “Getting 
started” chapter). 

2. Display card holder records (see “View card holder records,” the previous 
section in this chapter). 

3. If the Edit Bar is not displayed:  In the lower right corner of the 
D3000.Express window, click the Edit button to display the Edit Bar below 
the table. 

 

4. In the Edit Bar, click the Append button  .  This opens the Card Holder 
Detail dialog. 

 

5. In the Card Holder Detail dialog’s General tab: 

a. Enter the Site Code. 

b. Enter the Embossed# code. 



D3000.Express Installation and User’s Guide 19 

c. If this card has an associated PIN, enter the PIN (up to 5 digits) in the 
Comb/PIN field. 

d. In the First Name and Last Name fields, enter the card holder’s name. 

e. If this card will become active on a date after today, open the calendar in 
the Valid From field, then select the activation year, month and day. 

f. If this card will expire on a specific date, open the calendar in the Valid 
Thru field, then select the expiration year, month and day.  Otherwise, 
keep the default expiration date. 

g. If the Home Building Address is different than the default value, click the 
More button  to open the Select Building dialog.  Click the building 
address, then click the OK button.  In the Select Warning dialog, click the 
OK button to confirm the building address. 

h. In the Tenant field, click the More button  to open the Select Tenant 
dialog.  Click the tenant name for the new card, then click the OK button.  
In the Select Warning dialog, click the OK button to confirm the tenant. 

i. In the Access Level field, click the More button  to open the Select 
Access Level dialog.  Click the access level for the new card.  Click the 
OK button.  In the Select Warning dialog, click the OK button to confirm 
the access level. 

j. If you need to manually edit access details, or add additional building 
access not included in the original access level: 

i. Click the Append button  below the access level list. 

ii. In the Select Building dialog, click the building address, then click OK. 

iii. In the Card Send To Detail form:  In the Primary Access Level field, 
click the More button  to open the Select Access Level dialog.  Click 
the access level, then click OK.  Optional:  Repeat for the Secondary 
Access Level field. 

iv. If the building whose access you need to edit is already in the detail list, 
just double-click building in the detail list and follow the steps above to 
edit. 

k. As needed, enter: 
 Notes. 
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6. In the Card Holder Detail dialog’s Photo/Extra Fields tab: 

 

a. If the card holder will have a photo badge, see “Add a photo to the 
database,” next in this chapter. 

b. If the card holder is a Fire Warden, check the Fire Warden option. 

c. In the Event Notify Email field, enter the e-mail address where the card 
holder will receive event messages sent by the system. 

d. As needed, fill in fields in the Customer Field section. 

7. Click the Save button. 

8. Optional:  Click the New button to activate another card. 

9. Click the Close button. 

10. The new card holder record will initially be the last record in the table (if 
necessary, scroll down to see it).  It will have a check mark in the Pending 
Download column to indicate it is scheduled for automatic downloading to 
the access control hardware.  The new card can be used 30 to 60 minutes after 
you create the record. 
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Deactivate a card 

1. If records for multiple buildings are open, select the building for which you 
are deactivating a card (see “Open records for a building” in the “Getting 
started” chapter). 

2. Display card holder records (see “View card holder records,” earlier in this 
chapter). 

3. Locate the record for the card you want to deactivate.  Search using the Card 
Holder Search panel, or scroll through card holder records. 

4. Double-click the row containing the card you want to deactivate. 

5. In the Card Holder Detail dialog, click the Deactivate button. 

6. In the Delete Warning dialog, confirm that you are deleting the correct card, 
then click the OK button. 

Replace a card 

1. If records for multiple buildings are open, select the building for which you 
are deactivating a card (see “Open records for a building” in the “Getting 
started” chapter). 

2. Display card holder records (see “View card holder records,” earlier in this 
chapter). 

3. Locate the record for the card you want to deactivate.  Search using the Card 
Holder Search panel, or scroll through card holder records. 

4. Double-click the row containing the card you want to replace. 

5. At the bottom of the Card Holder Detail dialog, click the Replace button. 

6. In the Replace Card dialog: 
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a. Fill in the Site Code, Embossed# and Encoded# fields. 

b. Click OK. 

Add a photo to the database 

Since a photo badge needs a photo, this section shows how to add photos to the 
card holder database. 

Open or create a card holder record 

1. In the D3000.Express left panel, click the Card Holder List icon. 

2. In the Card Holder Search panel: 

a. If desired, narrow the search by entering specific search terms. 

b. Click the Search button. 

3. If you are adding a photo to an existing card holder record, double-click the 
record.  In the Card Holder Detail dialog, click the Edit button. 
 or 
If you are creating a new card holder record: 

a. Double-click any row. 

b. In the Card Holder Detail dialog, click the New button. 

c. Fill in information about the card holder. 

What you do next depends on whether card holder photos are captured using a 
camera connected to the computer or are stored on the local hard disk.  Continue 
in the appropriate section: 

 “Load the photo from disk” 

 “Capture the photo using a connected camera” 
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Load the photo from disk 

1. In the Photo section of the Card Holder Detail dialog, click the Load From 
File... button. 

2. In the Select Photo dialog, navigate to the directory where photos are stored, 
select the card holder’s photo, then click the Open button. 

3. In the Crop Image dialog: 

a. Using the cursor, drag diagonally across the photo to create a cropping 
rectangle. 

b. Drag the rectangle’s sides and/or corners to crop the photo. 

 

 Tip:  Photos should be tightly cropped so the card holder’s face will be as 
large as possible in the photo badge. 

 
c. Click the Crop button. 

 Note:  Cropping here does not alter the original image stored on disk. 

 
d. Click the OK button. 
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4. The card holder’s photo appears in the Card Holder Detail dialog.  Continue 
in “Make a photo badge,” later in this chapter. 
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Capture the photo using a connected camera 

1. In the Photo section of the Card Holder Detail dialog, click the Take 
Picture button.  This opens the Camera dialog. 

 

2. The Live Video panel shows the camera’s view of the card holder.  Adjust the 
camera as needed. 

3. Click the Take Picture button.  The photo appears in the Captured Photos 
section of the dialog. 
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4. Click the photo in the Captured Photos section.  It appears in the Selected 
Picture section. 

 

5. In the Selected Picture section: 

a. Using the cursor, drag diagonally across the photo to create a cropping 
rectangle. 

b. Drag the rectangle’s sides and/or corners to crop the photo. 

 Tip:  Photos should be tightly cropped so the card holder’s face will be as 
large as possible in the photo badge. 

 
c. Click the Crop button. 

d. Click the OK button. 
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6. The card holder’s photo appears in the Card Holder Detail dialog.  Continue 
in the next section, “Make a photo badge.” 
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Print a photo badge 

This section shows how to assign a template, preview the photo badge and print a 
photo badge. 

Assign a template and preview a photo badge 

1. Display card holders (see “View card holder records” in the “Common tasks” 
chapter. 

2. Double-click the card holder record you want to preview. 

3. In the Card Holder Detail dialog, click the Photo/Extra Fields tab. 

4. In the Badge section, open the Badge Template list, then click the template 
you want to use for this card holder. 

5. Click the Preview Badge button.  Notice that the placeholders in the template 
have been replaced with the photo and information from the database. 

 

6. Close the Preview window. 

7. In the Card Holder Detail dialog, click the Save button, then click the Close 
button. 
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Print a badge 

1. Display card holders (see “View card holder records” in the “Common tasks” 
chapter. 

2. Click the card holder row for which you want to print a photo badge. 
 or 
CTRL+click or SHIFT+click to select multiple card holder rows. 

3. At the bottom of the D3000.Express window, click the Batch Print Badges 
button. 

4. In the Select Building dialog, click the address for which you are printing 
badges, then click OK. 

5. In the Select Template dialog, select the Tenant and Template, then click 
OK. 

6. In the Select Template dialog, verify that the Tenant and Template fields 
contain the correct values.  If they don’t, open the list(s) and select the correct 
values. 

 

7. Click the OK button. 
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Modify a card 

1. If records for multiple buildings are open, select the building for which you 
are modifying a card (see “Open records for a building” in the “Getting 
started” chapter). 

2. Display card holder records (see “View card holder records,” earlier in this 
chapter). 

3. Locate the record for the card you want to modify.  Search using the Card 
Holder Search panel, or scroll through card holder records. 

4. Double-click the row containing the card you want to modify. 

5. In the Card Holder Detail dialog, click the Edit button. 

6. Change fields as needed. 

7. Click the Save button, then click the Close button. 

Pre-register a visitor 

The Visitor List enables you to pre-register visitors you know will be arriving at 
some time in the future.  Visitor information is available to guards— in the 
D3000.Visitor program—so they can verify visitor identities and print visitor 
badges. 

 Note:  Guards using D3000.Visitor can register unscheduled visitors. 

 
The visitor list is also used to register a visitor that will be visiting after hours and 
will need to use the outside telephone to request entrance.  The telephone 
automatically dials a Datawatch Central Station where the list is used to confirm 
that the visitor is allowed to enter the building. 

1. If records for multiple buildings are open, select the building for which you 
are pre-registering a visitor (see “Open records for a building” in the “Getting 
started” chapter). 

2. In the left panel, click the Visitor List icon.   

3. If the Edit Bar is not displayed:  In the lower right corner of the 
D3000.Express window, click the Edit button to display the Edit Bar below 
the table. 
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4. In the Edit Bar, click the Append button  .  This opens the Visitor Detail 
dialog. 

 

5. In the Visitor Detail dialog: 

a. In the Tenant field, click the More button  to open the Select Tenant 
dialog.  Click the tenant name (with suite number) expecting the visitor, 
then click the OK button.  
 or 
In the Suite field, click the More button  to open the Select Tenant 
dialog.  Click the tenant name (with suite number) expecting the visitor, 
then click the OK button. 

b. In the First Name and Last Name fields, enter the visitor’s name. 

c. Optional:  In the Password field, enter a word or phrase that can be used to 
further verify the visitor’s identity.  (Be sure to give the password to the 
visitor in advance.) 

d. In the Authorized By field, enter your name or the name of the person 
responsible for the visitor. 

e. If you or the responsible person would like to be notified by e-mail when 
the visitor arrives, activate the Email Notify option, then enter Author’s 
Email address. 
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f. Optional:  In the Authorized Area field, click the More button  to open 
the Select Building Area dialog.  Click the appropriate area, then click the 
OK button. 

g. Enter the Begin and End times (in 24 hour format) during which the visitor 
is allowed to be in the building. 

h. In the Valid From and Valid Thru fields, open the calendars and select the 
appropriate dates. 

i. If the visitor will need a photo badge, see instructions in “Add a photo to 
the database: Load the photo from disk” or “Add a photo to the database: 
Capture the photo using a connected camera,” earlier in this chapter. 

j. Click the Save button. 

k. Optional:  Click the New button to add another visitor. 

l. Click the Close button. 

The new visitor record will initially be the last record in the table (if necessary, 
scroll down to see it). 

Modify a pre-registered visitor 

A pre-registered visitor’s record will need to be updated when, for example, the 
visitor will arrive on a different day or time than originally scheduled. 

1. If records for multiple buildings are open, select the building for which you 
are modifying a visitor record (see “Open records for a building” in the 
“Getting started” chapter). 

2. In the left panel, click the Visitor List icon.   

3. Locate the visitor record you want to modify. 

4. Double-click the row containing the record you want to modify. 
 or 
Click the Edit button to display the Edit Bar below the table, then click the 

Edit button  . 

This opens the Visitor Detail dialog. 

5. In the Visitor Detail dialog: 

a. Click the Edit button. 

b. Change fields as needed. 

c. Click the Save button, then click the Close button. 
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Remove a pre-registered visitor 

Remove a pre-registered visitor when that visitor will not be entering the 
building. 

1. If records for multiple buildings are open, select the building for which you 
are adding a visitor (see “Open records for a building” in the “Getting started” 
chapter). 

2. In the left panel, click the Visitor List icon.   

3. Locate the record for the visitor you want to remove. 

 Tip:  Click the Visitor column name to sort by visitor name, then scroll to 
locate the record. 

 
4. Click the row for the visitor being removed. 

5. If the Edit Bar is not displayed:  In the lower right corner of the 
D3000.Express window, click the Edit button to display the Edit Bar below 
the table. 

 

6. In the Edit Bar, click the Delete button  . 

7. In the Delete Warning dialog, confirm that you are deleting the correct 
visitor, then click the OK button. 
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Advanced tasks 

This chapter describes additional table operations and provides instructions for 
tasks that are typically performed less frequently. 

Advanced table operations 

 To rearrange columns:  Drag the column name and drop it in the desired 
location in the column header. 

 To hide or show columns:  Right-click the box in the table’s upper left corner 
(to the left of all column names), then click the column name you want to hide 
or show. 
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 To filter the table (i.e., view only rows with specific data in one column):  
Hover over the upper right corner of the column name, click the little arrow 
that appears, then click the filter term. 

 

 To remove a filter:  Hover over the upper right corner of the column name, 
click the little arrow that appears, then click (All) in the pop-up menu. 

 

 Tip:  Other filter operations are available, but are beyond the scope of this 
manual.  Interested users are encouraged to explore the (Custom) 
command in the filter pop-up menu, and the Filter Editor... command in the 
column pop-up menu. 
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 To group rows by data in one column:  Use one of the following methods. 

 Drag the column name to the Group By box.  In the example below, the 
Emboss column name is being dragged to the Group By box... 

 

 which groups rows like this (one row is expanded to show the record in 
that group)... 

 

 Right-click the column name, then click Group By This Column in the 
pop-up menu (see arrow below). 

 

 Tip:  You can apply additional levels of grouping by repeating the above 
methods for other columns. 
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 To expand a group:  Click the plus sign  next to the group. 

 To expand all groups:  Right-click in the Group By box, then click Full 
Expand in the pop-up menu (see arrow below). 

 

 To collapse a group:  Click the minus sign  next to the group. 

 To collapse all groups:  Right-click in the Group By box, then click Full 
Collapse in the pop-up menu. 

 To ungroup rows:  Use one of the following methods. 

 Drag the column name from the Group By box back into the column 
header. 

 Right-click in the Group By box, then click Clear Grouping in the pop-
up menu (see arrow below). 
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Modify the holiday list 

1. If records for multiple buildings are open, select the building for which you 
are modifying the holiday list (see “Open records for a building” in the 
“Getting started” chapter). 

2. In the left panel, click the Holiday List icon.   

3. If the Edit Bar is not displayed:  In the lower right corner of the 
D3000.Express window, click the Edit button to display the Edit Bar below 
the table. 

 

4. Then: 

 To add a holiday: 

a. In the Edit Bar, click the Append button  . 

b. In the Select Holiday dialog, click the holiday you want to add, then 
click the OK button.  In the Select Warning dialog, click the OK 
button. 

 To edit a holiday: 

a. Double-click the holiday you want to edit. 
 or 

Click holiday you want to edit, then click the Edit button  . 
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b. In the Building Holiday Detail dialog, change fields as needed, click 
the Save button, then click the Close button. 

 To delete a holiday: 

a. Click the holiday you want to delete. 

b. In the Edit Bar, click the Delete button  . 

c. In the Delete Warning dialog, confirm that you are deleting the correct 
holiday, then click the OK button. 

View access history 

The access history list shows card holder access events. 

1. If records for multiple buildings are open, select the building for which you 
want to view access history (see “Open records for a building” in the “Getting 
started” chapter). 

2. In the left panel, click the Access History List icon.   

This displays the History Search panel. 

 

3. In the From and Thru fields, open the calendars and select the date and time 
range for the search (see “Select dates and times” in the “Getting started” 
chapter for details). 

4. To restrict the search to a specific tenant:  Open the Tenant list and click a 
tenant name. 

5. To search by one or multiple buildings:  Open the Search Location list and 
click the desired type. 

6. To further restrict the search:  Click a tab above the Search All button, then 
fill in or select the appropriate data. 

7. Click the Search button. 

 Note:  D3000.Express may not initially display all matching records.  Click the 
Load Next Page or Load All button to view additional records. 

 
8. To view details about an access record:  Double-click the record. 
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Managing access level templates 

 Note:  Creating, modifying or deleting an access level template can have 
unintended consequences, which may include allowing card holder access to 
unauthorized areas, or preventing legitimate access to authorized areas.  
Access level templates should only be worked on by Datawatch 
representatives or trained building management personnel. 

 
An access level template enables individual access levels to be grouped and 
named. By using access level templates, access levels can be conveniently and 
consistently assigned to card holders.  

Create an access level template 

1. If records for multiple buildings are open, select the building for which you 
want to view access level templates (see “Open records for a building” in the 
“Getting started” chapter). 

2. In the left panel, click the AL Template List icon.   

This displays the Access Level Template List. 

3. If the Edit Bar is not displayed:  In the lower right corner of the 
D3000.Express window, click the Edit button to display the Edit Bar below 
the table. 

 

4. In the Edit Bar, click the Append button  .  This opens the Select Tenant 
dialog.  Select the tenant for which you are creating an access level template, 
then click OK. 
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5. In the AL Template Detail dialog’s General tab: 

 

a. Optional:  Override the system-assigned Template#. 

b. Optional, but recommended:  Enter a Summary and Notes for this 
template.  This information will help you and other understand the 
structure and reasoning behind the template. 

6. In the AL Template Detail dialog’s AL Template Detail tab: 

a. Click the Append button  . 
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b. In the Select Building dialog, click the building having the target access 
level, then click OK.  This displays the Tenant AL Template Detail 
dialog: 

 

c. In the Primary Access Level field, click the More button  to open the 
Select Access Level dialog.  Click the desired primary access level, then 
click OK. 

 Tip:  If you need more information about an access level, in the Select 
Access Level dialog, click that access level, then click the Detail… button. 

 
d. Optional:  In the Secondary Access Level field, click the More button  

to open the Select Access Level dialog.  Click the desired secondary access 
level, then click OK. 

e. In the Tenant AL Template Detail dialog, click OK. 

f. Repeat steps a through e to add more access levels to the template. 

7. Click Save, then click Close. 

Modify an access level template 

1. In the Access Level Template List, double-click the template you want to 
change.  This opens the AL Template Detail dialog. 

2. Click Edit. 
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3. In the General tab, change information as needed. 

4. In the AL Template Detail tab: 

 To add an access level to the template:  Click the Append button  , 
select a building, select a primary and (optional) secondary access level, 
then click OK. 

 To remove an access level from the template:  Click the access level you 

want to delete, click the Delete button  , then confirm the deletion. 

5. Click Save, then click Close. 

Delete an access level template 

1. In the Access Level Template List, click the template you want to delete. 

2. In the Edit Bar, click the Delete button  . 

3. Confirm the deletion. 

View the card send to list 

The Card Sent To List provides “send to” details for each card, including card 
holder name, address where the card can be used, and primary and secondary 
access levels. 

1. If records for multiple buildings are open, select the building for which you 
want to view access level templates (see “Open records for a building” in the 
“Getting started” chapter). 

2. In the left panel, click the Card SendTo List icon. 
   
This displays the Access Level Template List. 

3. To reduce the number of records displayed:  Enter search terms in the search 
panel, then click the Search button. 

4. To view all details about a particular card:  Double-click the row for that card. 
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Manage the access deny list 

The Access Deny List identifies individuals that are not allowed to enter a 
particular building. 

View the access deny list 

1. If records for multiple buildings are open, select the building for which you 
want to view access level templates (see “Open records for a building” in the 
“Getting started” chapter). 

2. In the left panel, click the Access Deny List icon. 
   
This displays the Access Deny List.  

Add an individual to the access deny list 

1. In the Edit Bar, click the Append button  .  This opens the Access Deny 
Detail dialog. 

 

2. Fill in the individual’s First Name and Last Name. 

3. As needed, fill in Notes. 

4. Click the Save button. 
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Remove an access deny record 

1. In the Access Deny List, double-click the record you want to remove. 

2. In the Access Deny Detail dialog, click the Delete button. 

3. Confirm the deletion. 
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Using Photo Badge Designer 

Photo Badge Designer is part of the D3000.Express access card and key 
administration program.  Designer can be used to create and edit templates for 
photo badges.  By combining card holder data with a template in D3000.Express, 
you can create photo badges for individual card holders. 

Datawatch Systems can design photo badge templates for you for a small fee.  
Photo Badge Designer is provided for those users that prefer to design their own 
photo badge templates. 

This chapter is organized in three sections: 

 “Access Photo Badge Designer” shows how to launch Photo Badge Designer 
from within D3000.Express. 

 “Designer overview” identifies the main elements of Designer’s user 
interface, introduces tools for creating objects, and explains object properties. 

 “Template tutorial” provides step-by-step instructions for using Designer to 
create an example photo badge template. 
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Access Photo Badge Designer 

1. Launch D3000.Express and log in. 

2. If you are a tenant:  Go to step 3. 
 or 
If you are a property manager:  If records for multiple buildings are open, 
select the building for which you want to edit or create a photo badge 
template. 

3. In the left panel, click the Badge Template List icon.   

This displays the current list of photo badge templates.  Continue in the 
appropriate section below. 

To edit an existing template 

1. Double-click the row containing the template you wan to edit.  This opens the 
template in the Badge Template Detail dialog. 

2. In the Badge Template Detail dialog, click the Edit button, then click the 
Design... button.  This opens the Designer application, where you can edit the 
template. 

To create a new template 

1. If the Edit Bar is not displayed:  In the lower right corner of the 
D3000.Express window, click the Edit button to display the Edit Bar below 
the table. 

 

2. In the Edit Bar, click the Append button  .  This opens the Badge 
Template Detail dialog. 

3. In the Badge Template Detail dialog: 

a. If you are a property manager:  Click the More button in the Tenant field, 
then click a tenant name. 

b. In the Template Name field, enter a name for the template. 

c. Click the Design... button.  This opens the Designer application, where 
you can create the template. 
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Designer overview 

Main window 

 

The Designer main window includes the following components: 

 Tool Bar 

 Property Window 

 Tool Box Window 

 Badge background 

 Tip:  You can resize the badge background to any required size. 

 
Additional information is provided in the next sections. 
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Tool Bar 

The Tool Bar provides one-click access to many of the commands in the File, 
Edit and Layout menus. 

 

Tool Box Window 

The Tool Box Window, along the left side of the Designer main window, 
provides several tools for creating and manipulating objects. 

 
Property Window 

Here is what you can do with the tools: 

 Pointer tool:  select, move and resize objects. 

 Text tool:  create static text that will appear on every badge, and create text 
placeholders where card holder data will be substituted when generating 
badges. 

 Picture tool:  place images that will appear on every badge, and create picture 
placeholders where card holder photos will be substituted when generating 
badges. 

 Line tool:  draw lines. 

 Shape tool:  draw rectangles. 

 Barcode tool:  create barcode placeholders where card holder data will be 
substituted—and a corresponding barcode will be produced—when generating 
badges. 
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Using the tools 

 To create objects: 

All the tools work about the same way: 

1. In the Tool Box Window, click the tool you want to use. 

2. Drag or click on the badge background to create a new object. 

3. Use the Pointer tool to move and resize the object (see below). 

4. With the object selected, edit its properties in the Properties Window. 

 To move objects: 

 Use the Pointer tool to drag the object, or 

 Enter new values in the object’s Location > X and Location > Y 
properties. 

 To resize objects: 

 Use the Pointer tool to drag the object’s side or corner handles. 

 Enter new values in the object’s Size > Width and Size > Height 
properties. 
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Property Window 

The Property Window, along the right side of the Designer main window, lists 
properties for the currently selected object. 

In the example below, a text object is selected.  The Property Window lists the 
editable properties for that text object.  The following changes were made to the 
text object’s default properties, and you can see the changed property values 
(indicated by arrows) in the Property Window: 

 Font > Name changed to Arial. 

 Font > Size changed to 14 points. 

 Font > Bold changed to True (i.e., the text is bold). 

 Text object content changed to “Example Text”. 

 

Property Window 
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The panel at the bottom of the Property Window displays a description of the 
currently selected property.  In the example above, the Text property is selected, 
and its description appears in the panel. 

 Tip:  Some object is always selected.  If no placed objects are selected, then 
the badge background is selected, and the Property Window then shows 
properties for the badge background.  The screen shot in the “Main window” 
section, earlier in this chapter, illustrates this case—the badge background is 
selected, and its current properties are listed in the Property Window. 

 

Viewing properties 

Some properties are organized in groups.  You can show or hide properties within 
each group. 

 To expand a group to see its properties:  Click the    next to the group name, 
or double-click the group name. 

 To collapse a group to hide its properties:  Click the    next to the group 
name, or double-click the group name. 

Here is an example: 

Text object properties fully collapsed 

 

Text object properties fully expanded 
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Changing property values 

When you create an object, Designer assigns default values to each of the 
object’s properties.  Your job is to change those default values so the object 
appears and functions the way you want it to. 

 To change a property’s value:  Click the property’s name, then enter or select 
a new value. 

 Tip:  When a property is selected for editing, it appears as white lettering on a 
blue background.  In the example below, the BackgroundImage property is 
selected. 

  

 
There are several methods for changing property values, and the method depends 
on the property being edited.  Here are some examples: 

 For properties having a number value, simply type a new number. 

   

 Tip:  Most default values are shown in normal style, while values you enter or 
select are shown in bold.  In the example above, 1 is the default value, which 
the user has changed to 55. 

 

 For properties having a text value, simply type new text. 

   

 For properties offering a list of values, open the list and click the value you 
want. 

 



D3000.Express Installation and User’s Guide 54 

 Some properties only give you a choice of True (i.e., apply the property) and 
False (i.e., don’t apply the property). 

 

 Some property groups, when selected, display a More button  .  Click this 
button to open a related dialog.  The Font group, for example, enables you to 
set a variety of text characteristics. 

 

 Click the More button (indicated above by arrow) to open the Font dialog, 
which provides a more traditional approach for specifying text properties. 
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 For colors, a panel containing three tabs opens.  Click a tab (Custom, Web or 
System) to select the method for specifying the color, then click the color you 
want. 

 

 

 Tip:  You can change the width of the property and value columns in the 
Property Window.  Hover over the top-most property until you see the double 
arrow cursor, then drag left or right. 

  

 You can also change the width of the Tool Window and Property Window by 
dragging their inner borders. 
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Template tutorial 

This section takes you step-by-step through the creation of a new photo badge 
template.  So you’ll know where we’re headed, here’s a preview of the finished 
template you’ll be making, with key features indicated. 

 

You’ll learn a lot about using Designer by reading this tutorial.  You’ll learn even 
more if you perform each step in Designer. 

Start 

1. Launch D3000.Express and log in. 

2. In the Select Building dialog, click the address for your building. 

3. In the D3000.Express left panel, click the Card Holder List icon. 

4. In the Card Holder Search panel, click the Search button. 

5. In the lower right corner, click the Edit button. 

Company logo 
 
 
 
Light brown background 
 
 
 
Card holder photo placeholder 
 
 
 
 
 
 
 
Card holder name placeholder 
   in white box 
Card holder department placeholder 

Brown line, 4 points high 
 

Barcode placeholder 
   (same as emboss code) 
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6. In the Edit Bar, click the Append button  to open the Card Holder Detail 
dialog. 

7. Click the Photo/Extra Fields tab. 

 

8. Notice the CUSTINFO1 through CUSTINFO8 fields in the Customer Field 
section.  They are labeled CUSTINFO1 through CUSTINFO8 here, but may 
have different labels for your building/tenant. 

 Note:  Custom field labels can be defined in D3000.Lite.  These fields are 
useful for recording building- and tenant-specific information for individual card 
holders. 

 

Create a new template 

1. In D3000.Express’s left panel, click the Template List button. 

2. In the lower right corner, click the Edit button. 

3. In the Edit Bar, click the Append button  . 
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4. In the Select Tenant dialog, select a tenant, then click the OK button.  In the 
Select Warning dialog, click the OK button. 

5.  In the Tenant Badge Template Detail dialog. 

 

6. In the Tenant Badge Template Detail dialog: 

a. Open the Badge Type list, then click Card Holder Badge. 

b. In the Template Name field, enter a name, such as Example 
Template, for the template. 

c. Click the Design... button.  This opens the Designer application. 
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Set the background color 

1. In the Property Window, click the BackColor property. 

2. Click the arrow at the right end of the 
BackColor property’s value field. 

3. In the color panel, click the Web tab. 

4. Scroll down to find the NavajoWhite 
color, then click it. 

 

The badge background is now a light 
brown color. 

 

 Note:  To save space, screen shots in this tutorial show the Designer window  
resized into a compact configuration.  You can resize the Designer window, or 
work with it in its default size (which fills the screen). 

 

 Tip:  The badge background can also be an image you created in another 
application.  To import a background image, click the BackgroundImage 
property, click the More button to get a file open dialog, then select and open 
the background image. 
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Add the logo 

1. Click the Picture tool. 

2. Click on the badge background to create a new picture object. 

3. Using the Pointer tool, move and resize the picture object so it’s a rectangle 
near the top of the background. 

4. With the picture object still selected, click the Picture property, then click the 
More button at the right end of the value field. 

5. In the Open dialog, select any logo or image (we’ve used the Datawatch logo, 
but any image will do for this tutorial). 
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Add the photo placeholder 

1. Click the Picture tool. 

2. Click on the badge background to create a new picture object. 

3. Using the Pointer tool, move and resize the picture object so it’s a square 
about the size and position shown below. 

 This object will serve as a placeholder for card holder photos.  When a badge 
is created for a card holder, that person’s photo will substituted for this 
object’s gray area.  Card holder photos are stored in the Photo column of the 
Card Holder List.  We need to associate this picture object with that column 
so D3000.Express will know where to get the card holder’s photo. 

4. With the picture object still selected, click the Data > Field Name property. 

5. Open the Field Name property’s list, then click Photo. 
This associates the picture object with the Photo  
column in the Card Holder List. 
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Add the card holder name placeholder 

1. Click the Text tool. 

2. Click or drag on the badge background to create a new text object. 

3. Using the Pointer tool, move and resize the text object so it’s a rectangle 
about the size and position (just under the photo placeholder) shown below. 

4. With the text object selected, click the Font property, then click the More 
button to open the Font dialog.  Set Font to Arial, set Font Style to Bold, and 
set Size to 12.  Click the OK button to close the Font dialog. 

5. Click the Text property.  Select its current value (TextControl1), then type 
Name .  This helps identify what the object does in the template. 

6. We’d like the name to appear in a white box.  Click the BackColor property.  
Click its arrow to open the color selector.  Locate and click White (it’s near 
the top of the Web color list). 

 This object will serve as a placeholder for card holder names.  When a badge 
is created for a card holder, that person’s name will substituted for the text in 
this object.  We need to associate this object with the card holder name 
column in the Card Holder List, so D3000.Express will know where to get 
the card holder’s name. 

7. Click the Data > Field Name property.  Open the property’s list, then click 
Name. 

 



D3000.Express Installation and User’s Guide 63 

Add a custom info fields placeholder 

1. Click the Text tool. 

2. Click or drag on the badge background to create a new text object. 

3. Using the Pointer tool, move and resize the text object so it’s a rectangle 
about the size and position (just under the name placeholder) shown below. 

4. With the text object selected, click the Font property, then click the More 
button to open the Font dialog.  Set Font to Arial, set Font Style to Bold, and 
set Size to 10.  Click the OK button to close the Font dialog. 

5. Click the Text property.  Select its current value (TextControl2), then type 
Department .  This helps identify what the object does in the template. 

 Like the photo and name placeholders, this one needs to be associated with a 
card holder data field—in this case it’s the CUSTINFO1 custom field. 

6. Click the Data > Field Name property.  Open the property’s list, then click 
CUSTINFO1 (the custom field). 
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Add the horizontal line 

1. Click the Line tool. 

2. Click or drag on the badge background to create a new line object. 

3. Using the Pointer tool, move and resize the line so it extends from edge to 
edge and is located just below the department placeholder. 

4. Click the LineColor property.  Open this property’s color panel.  Scroll down 
to find the SaddleBrown color, then click it. 

5. Click the LineWidth property.  Select this property’s current value, then type 
4 .  This sets the line’s width to 4 points. 
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Add the barcode placeholder 

1. Click the Barcode tool. 

2. Click below the brown line to create a new barcode object. 

3. Using the Pointer tool, move the barcode object to about the position shown 
below. 

 We want the card holder’s emboss code to appear on the badge as a barcode in 
the same position as the barcode placeholder.  We need to associate the 
emboss code field with the barcode placeholder. 

4. Click the Data > Field Name property.  Open the property’s list, then click 
Emboss. 
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Finish up 

1. Using the Pointer tool, SHIFT+click the six objects you placed on the badge 
background. 

2. Click the Align Middle button  in the Tool Bar to center the objects in 
relation to each other. 

3. Press the keyboard arrow keys to nudge the objects so they are centered over 
the badge background. 

4. Click the Preview button  in the Tool Bar to admire your work.  Close the 
preview window to return to Designer. 

 

5. File > Exit to return to the Photo Template Detail dialog in D3000.Express. 

6. In the Photo Template Detail dialog, click the Save button, then click the 
Close button. 

The new template will be added to the template list. 

 


